3. Google Earth Pro

This set of tutorials introduces you to Google Earth Pro (*not* Google Earth Web or Google Earth Desktop, which are covered in different tutorials). Google Earth Pro is recommended for use at the high school level. The browser - Google Chrome - is now required to download Google Earth, so, if you do not already have Google Chrome, you can download it by clicking this link:

https://www.google.com/chrome/browser/desktop/index.html

3.1 Introduction

Google Earth has three formats—(a) an on-line web version, (b) a mobile version, and (c) a version called Pro. In this tutorial, we explore the Pro version. Google Earth Pro, like the other two versions, is a GIS because it provides a map display and Table of Contents which permits layering multiple files on top of the map document. Further, it has some basic features of a GIS that allows some personal mapping. An older version was just called Google Earth Desktop and was replaced by Google Earth Pro. In most instances, if you had Google Earth Desktop during the update, it was replaced by Pro. For a YouTube video introducing you to the Google Earth suite of products, go to https://youtu.be/DaluBU8ZO3A.

We will not cover all features and abilities within Google Earth Pro. We will cover the basics - navigating, metadata, historical imagery, properties, dual Table of Contents and a few enhancements in Google Earth Pro that are not found in the other two Google Earth versions.

3.2 Let’s Get Started – Downloading Google Earth Pro

Our YouTube video introduction Google Earth Pro is found at: https://youtu.be/JStJz-AUYvQ.

Please note, if you are a K-12 Educator, please read the Google Earth Acknowledgement and Use Agreement form as restrictions do exist depending on ages of your students. The Google Earth Agreement and Use Terms can be found at:

https://www.google.com/earth/download/gep/agree.html

Once you have read this document, and if you have agreed to it, you will receive a prompt to download Google Earth Pro.
Once you have downloaded, follow the instructions to run and add the program to your computer. Once you have completed the install, you can add a short cut to your desktop by right-clicking on the program and adding to desktop. Please note that you must have administrator capability on your computer to install Google Earth Pro. If you are working on an educational institution’s computer, contact your IT Department about downloading Google Earth Pro. If you are working from a mobile device, see the tutorial on Google Earth Web, which is available for mobile devices.

You will see this icon:

Now that you have downloaded and installed it, let’s get started.

3.3 Google Earth Pro Basics

Open Google Earth Pro by doubling clicking on the icon. You will see the following:
Start-up tips is enabled. We recommend that you leave this enabled until you are familiar with using Google Earth. If you don’t want it enabled, unclick the box at the bottom that says Show tips at start-up (red rectangle above). Once you have finished reading this information, click Close and the following will show:
Exploring Our Planet with Open Source Software

We are going to explore this window for a bit. On the left is the Table of Contents (actually two different ones -- we will discuss these later). On the right is the Map Window.

Within the Map Window, you see the lines for the Geographic Grid (in this display, lines of latitude and longitude). At this extent, it is only showing major divisions. You can turn Geographic Grid on and off-- we will cover that under *settings*.

In the upper right hand corner are the *navigation tools*.

- You can:
  - Rotate the Earth, north and south or east and west, with either of the two icons.
  - Zoom in and out with the slider bar (you can also zoom in and out with your mouse wheel).
  - Play with these icons. Can you get the Earth to turn upside down (south on the top and north on the bottom)?

3.4 Metadata

Metadata is an important topic to understand. Go to the lower left hand corner for your first set of metadata. From right to left, you find altitude, latitude and longitude and the imagery date. Because we are in space right now looking at the Earth, the altitude is quite high, and measured in miles. As you zoom in, this will change. How do you know what spot on the Earth this figure represents -- it is where your mouse pointer is located. The latitude and longitude is also for the location of your mouse pointer. In this display, latitude and longitude read as degree minutes and decimal seconds. Later, we will discuss how you can change these settings. At this extent, if you were to put your mouse in space, that reading will disappear. Finally, the image date – for this extent, this map of the Earth is a composite of the images, so the date displayed here represents the latest date for the composite images. As you zoom in and out, this date will change to the latest date that Google has of an image for that specific location on the Earth. This date also changes when viewing historical imagery, which will we cover later.

The other metadata information is extremely important – the source of the image displayed in the Map Window. This is located in the center, at the bottom. When you are zoomed out to this extent, you see many sources because, again, this extent is a composite of images.
If you were to zoom into one specific locale, you would get more specific information, for example, Grand Junction, Colorado – here, we see an aerial photo (USDA) instead of a satellite image.

If you continue to zoom in and go to the extent of Street View, you will get © 2018 Google. Most street view images are acquired by Google.

Other metadata can be found throughout Google Earth, especially when adding files under My Places or look at the Layers already displayed in Google Earth. We will discuss those as we proceed.

### 3.5 Changing the Default Settings in Google Earth Pro

For the YouTube video related to this section, go to: [https://youtu.be/lXqzT4zUkE0](https://youtu.be/lXqzT4zUkE0).

Google Earth loads with many default settings, which you can change. On the Toolbar, go to *Tools, Options*.
The following window opens:

We will not discuss each of these. For example, the first row of boxes – Texture Colors, Anisotropic Filtering, and Graphics Mode – if you need more information about these capabilities, contact your IT Departments.

The second row, 1st box – Show Lat/Long, here is where you can change the display of your Latitude and Longitude. Decimal Degrees would look like:
And, Universal Transverse Mercator (UTM) locationa data look like this:

![UTM Zone Example](image)

UTM Zone – 40R and the coordinates in meters, East and North of the zone’s origin. You have only changed the coordinate system, so the elevation and altitude are still showing in the default settings of feet and miles.

If you change the *Unit of Measurement* (the next box), the values will display now as meters. You can also change other options in this specific window to help with faster rendering. We briefly will look at some of the other tabs.

*Cache* – is related to memory, check with your IT Department on any changes.

*Touring* and *Navigation* tabs are setting specific to zooming in and out, flying around in Google Earth, etc.

The *General* tab contains settings that might be helpful with regard to changing language displayed for a non-English speaking student, emailing, tooltips, how errors are displayed, etc. If you are new to Google Earth Desktop, enabling *Show start-up tips* is recommended (red box).

![Google Earth Options](image)

We won’t discuss these as they are each an individual choice as to how you want to receive information, or how your IT Department feels your emails, or access to local drives should be handled. The best thing about *Options* is the button on the bottom left, *Restore Defaults*. You don’t need to remember what they were, just hit the button and click *OK* or *Apply*. 
3.6 Exploring the Historical Imagery Option

For the YouTube Video for this section, go to: [https://youtu.be/7r1ETosfKmU](https://youtu.be/7r1ETosfKmU).

For this next section, go back to Dubai and then zoom in on the coastal area as shown below (no, the white arrows are not present on your screen):

![Google Earth Map](image)

We are going to examine changes to the coastal area using Historical Imagery within Google Earth. Most specifically, human changes which added the Palm Islands (white arrows).

You can access the *Historical Imagery* option in two areas. 1st- on the toolbar, go to *View* and check *Historical Imagery*. 
Or, on the toolbar with icons, click on the icon within the black circle below:

Both options turn on the *Historical Imagery* sliding bar, which will pop up in the upper left of the Map Window.

As you can see, Google Earth has Historical Imagery for Dubai extending back to 1984 (red circle above). You can either grab the slider with your mouse and slide it back and forth, or use the arrows at each end of the line – going to the left, the imagery gets older, and, to the right, more recent imagery is displayed.

Before we talk more about what happens in the Map Window, let’s look at the sliding bar a bit closer. In the upper left corner of the pop-up window are two zooms – these zoom in and out on the divisions in the sliding bar. As you can see below, one click on the *Zoom In* changed the display to go back only to 2007, but each white division line represents one historical image.

In accordance with the screenshot below, move the sliding bar to the left to 1984 and placed your mouse on one of the white lines. It shows the dates that each white bar represents.

Clicking on zoom out, you can change the sliding bar back to the original time line.

The setting button (red circle above) allows you to change the Date and Time Options for Historical Imagery.
Let’s now look at what happens in your Map Window when using the sliding Historical Imagery bar. When you first click on the slider, the screen changes, and the date of the image is placed on the lower information bar on your screen and the image source in the bottom middle.

Remember, the image source also changes when you zoom in and out.

Now either slide the slider to the left or click once on the left arrow. Look at the bottom, the image source is the same but the image date is now 12/30/2015. Keep clicking and watch how the features (called Palm Islands) in the Persian Gulf have changed, most specifically watch the areas indicated by the white arrows. The screenshot below is 12/30/2004.
12/30/2002, only one of the three Palm Islands is even partially present:

12/30/1984 below – not only are the Palm Islands not present, but look at the change in the extent of the urban area. You can use the historical imagery to show changes over time.
Additional Examples of Changes Over Time

Question – what is the source of the 1950 image of Las Vegas?  (Answer – NASA, obtained from the U.S. Geological Survey – do you remember how we found this metadata?)

Loss of water from the Aral Sea, 1972 to 2016
3.7 Exploring the Table of Contents – My Places

For the YouTube video related to this section, go to: https://youtu.be/EJPUY4QDGyI.

We are now going to discuss the top Table of Contents – My Places. This is where Google Earth records your activity as Temporary Places, but you do have a saving option. You could see it recorded when we clicked on the individual photo (red box). You can remove these – right-click on the file name and hit delete.

Google Earth will ask you if you are sure. click OK.

My Temporary Places are now empty.
Adding a Placemark

You can add placemarks for places of your choice. To add a placemark, search for the location you wish to add a mark. Once you have found that location, and it appears in the Map Window. Now go to Add, Placemark (red rectangle below).

This adds a placemark in your map window, the yellow pushpin and opens the New Placemark window. If the placemark is not in the exact location you want it, you can move the Earth view around to put your placemark exactly where you want it. The latitude and longitude showing in the New Placemark window will change as you move it.

In the screenshot below, we are under the Description tab and the Name bar is highlighted (red rectangle). You can name your placemark anything you want. You can also add text, links, or images in the freeform box.
You can also change the icon from a pushpin. In the red box in the screenshot above, click on the button that has the yellow pushpin and you get an icon window. You can choose any of these, or click on Add Custom Icon at the bottom to get a browse window and choose another type of icon. For our purposes, we are just leaving it as a pushpin.

Below, the placemark was named “Where I want to visit”, and it also changed the name in the Map Window.

The color was originally yellow (prior screenshot), but look it is now blue. Click on the Style, Color tab and you can change the label and icon colors. You can also change the scale (size) and opacity. Go ahead and experiment to see what best suits your purposes.

Click on the text tab – View. Here is an additional setting for the Map Window that you can change. For example, checking the box next to Center in View (red rectangle) will move the icon into the center of the Map Window. Note – it won’t place your location in the center of the Map Window, it moves the placemark icon into the center, so be careful that is exactly where you want your placemark.
Click on the last tab – *Altitude*. Normally, we want our placemark *Clamped to the ground*, but as you can see, we have additional setting, if you want to view the differences or are interested in distances to or above the sea floor (of course, this likely only makes sense for coastal areas).

*Please note that we do not recommend that you use Google Earth for calculating distances for rock climbing, snorkeling, scuba diving or any other activity that could result in injury or loss of life.*

Depending on which setting you choose, you will enable the *Ground to Space* sliding bar (as you slide to the right towards the word *Space*, you zoom out and the altitude measurement is added), the *Extend to ground* (lengthens the height of the cursor above ground) or the *Track cursor height* (tells you the length of the cursor above the ground) options.

![Image of Google Earth interface showing placemark settings]

When you have completed and are happy with your settings, click *OK* and it will add your placemark to your *Temporary Places*.

![Image of Google Earth interface showing temporary placemark]

If you now close Google Earth (without taking any additional steps), you will get a dialog box asking if you want to save your placemark in your “*Temporary Places*” folder to your *My Places*
folder or discard. If you save to My Places, it will show up next time you open Google Earth. You can also save it before you close Google Earth. See below.

As you can see from this dialog box, you also have many other options. You can copy your placemark, you can delete it, rename it, email it. If you have not set your email (remember from Google Earth settings discussed above, you need to set your email), you will get the dialog box on the right.

From the dialog box on the left, you also can get directions, and there is also a Properties link.

If you click on Properties, it takes you to Edit Placemark, where you have the same tabs discussed above for Description, Style, Color, View and Altitude. So, if you don’t like what you set when you added your placemark, here is where you can make changes.

To save any placemarks before closing Google Earth, right click on the name of your placemark in the Table of Contents, then click on Save to My Places. If you have a specific folder where you want to save it---for example, a folder for a specific class project which you are using Google Earth, click on Save Place As and then navigate to the file folder where you want to save². Once you have saved your placemark, it moves to My Places.

² If you don’t already have a file folder set up, you can right click on My Places to create one.
There are multiple ways to add placemarks. You can right-click on the words *My Places* and add a placemark directly there, or you can right click on the words *Temporary Places* and add a placemark.

### 3.8 Table of Contents – Google Earth Default

Two YouTube videos are available on the Default Table of Contents. The first video, covers those layers listed before *More* ([https://youtu.be/KvjRgT2icME](https://youtu.be/KvjRgT2icME)) and the 2<sup>nd</sup> one covers those layers found under *More* ([https://youtu.be/ykILdv3A2TA](https://youtu.be/ykILdv3A2TA)).

On the left-hand side are two Table of Contents. The one on the top is called *My Places* (as discussed earlier) and this is where you will see any new files (layers) that you add to Google Earth.

The bottom Table of Contents automatically comes with default content. Yours may look just a bit different – all layers have check marks, which means all of these layers are turned on. You can turn layers on and off by checking or unchecking. (The same applies when you start adding your own layers to *My Places*.) Go ahead and check them all.

Let’s see how some of these work. First go to the top of the Table of Contents and search for Dubai, United Arab Emirates. You will see this:
It’s a bit messy. That is because we have all the layers turned on. Uncheck all layers except *Borders and Labels*. Your image should now look similar to this, much cleaner. But what is the symbology?
In the Table of Contents, click on the > next to *Borders and Labels* (red circle to the left) to expand it. It expands into two more categories – *Borders* (polygons) and *Labels* (points). But notice, we have two (2) more >, one next to each category. Click on each of these to expand further.

First, look under *Borders*, we now have 6 different layers. Yellow polygons, hollow inside, are *International Borders* and *Coastlines*; light blue are *1st Level Administrative Borders (States/Provinces)* and cyan is *2nd Level Administrative Borders (Counties)*. The Flags are layers including *Country Names* and *1st Level Administrative Names (States/Provinces)*. We only see *International Borders* and *Coastlines* in Dubai because United Arab Emirates does not have the same Administrative levels as found in other countries.

Now look under *Labels*.

We have red points for *Populated Places*, a point surrounded by a circle for *Islands*, green triangles for *Geographic Features* and waves for *Water bodies*.

We only see some red points in the extent for Dubai because the other features are not present.

If you want to see what some of these other features look like in your Map Window, zoom into the state of Colorado, United States. We now have both *Administrative Levels* and some *Geographic Features*. You see only *1st Level Administrative Names* because we are not zoomed in close enough to see the county names.

In this Table of Contents, the symbology is set by Google, you can only turn it on and off, you cannot change the colors or the icon.
Let’s explore another layer. Please now go back to Dubai.

Check Photos and you will see little images of jpegs but also a red circle with 360 on it. (If you don’t see any 360 photos, you may need to zoom in a bit.) Click on one of the red 360 circles. It provided a pop-up with additional information – more metadata. Go ahead and close the pop-up.

Now, click on any of the photo icons. You get a photo that has been uploaded by an individual person (image on the left below). In this case, the person uploaded two. If you have photos of a specific location, you can upload them to Google Earth. However, if you do so, you lose the rights to the photos, they become public domain—thus, a screen shot, as seen below, can be done. If you click on Click on this image to fly… (underneath the image), if Google has a Street View, you will get that (it does not for this location). Otherwise, you will might get a blurry...
Exploring Our Planet with Open Source Software

image (middle image below). You can click on the Street View icon and if a Street View image is not available, you will see ground view, noted in the upper right hand corner of the Map Window (image below on the right).

Terrain Layer

What is terrain?

Do a search for Great Sand Dunes National Park and Preserve, Colorado.

Now zoom into ground view level – right into the balloon labeled Great Sand Dunes National Park and Preserve. Once you have ground view level, uncheck (right image below) and check the Terrain layer (left image below). Terrain gives you the 3D view.
Go ahead and turn others on and off to familiarize yourself with the data provided. Most of these are self-explanatory.

**Satellite Imagery**

The messiest layer is *More*—we will discuss that just a bit. If you click on the > in front of the word *More*, it extends the number of layers. Now you can see why *More* is messiest—it is adding at least 9 more layers. Many of these, again, you can explore on your own and are self-explanatory.

Two of these layers require additional discussion—*Spot Image* and *DigitalGlobe Coverage*. Turn off all but Spot Image. You don’t see much, except some lines. Spot is a satellite system and the lines represent the boundary of the satellite scene\(^3\) covering the area. Let’s take a closer

---

\(^3\) A Spot Scene boundary is the area covered by one Spot Satellite image. For more information on Spot, and Spot One World, One Year go to [http://www.intelligence-airbusds.com/en/143-spot-satellite-imagery](http://www.intelligence-airbusds.com/en/143-spot-satellite-imagery) or
look. Turn off all the layers except Spot Image, Spot One World, One Year. Zoom out just a little bit so your Map Window looks like the following screenshot (we need to be able to see the boundaries of one Spot scene):

Click on any one of the round circle icons (inside the red circles). This pop-up provides additional metadata for the satellite image contained within the boundaries shown. An image acquired by Spot 5 on 18 MAY, 2011 07:02:58 UTC (Coordinated Universal Time, formerly Greenwich Mean Time).

https://www.gim-international.com/content/news/spot-image-launches-one-world-one-year-imagery-layer-on-google-earth
Now, turn off Spot and turn on DigitalGlobe\textsuperscript{4} Coverage. This is the messiest of them all. If you expand the layer, you have multiple years of DG Coverage. You can turn these, individually, on and off. In the screenshot on the left, 2009 is turned on 2009 and the layer expanded. You have different levels of cloud cover. The blue boxes are actually the boundaries of the individual scene.

\textsuperscript{4} For more information on DigitalGlobe Satellite systems, go to: https://www.digitalglobe.com/content
Look at the Map Window-- you see lots of lines and DG in a blue box with a date underneath in red (metadata). The date tells you the date of the Digital Globe Image (again, you may need to zoom in or out to see these). If you click on the blue box – it provides some metadata on the image – including the Digital Globe ID No., the Cloud Cover and Quality data. It also has the word preview. You can click on that word and then you have to be patient while it loads the Digital Globe image. You have to be very patient, it takes time to load.
You might also have the page expire, depending on your internet connection. You may need to click on Open in Firefox button in the upper right hand corner.

We are going to end our exploration of the Google Earth Pro provided Table of Contents, here. Again, you can further explore on your own.
Adding external files to Google Earth Pro

3.9.1 KML Files

First, we need KML files. Go to https://www.census.gov/geo/maps-data/data/tiger-kml.html and we can get a KML files for your use. For the YouTube video on finding KML files, go to: https://youtu.be/8blweAYxQoM.

You get this website – the US Census Bureau has files with boundaries at many different scales that you can download.

Click on Region.

What is KML? KML stands for Keyhole Markup Language, which is a file type supported in Google Earth. See https://developers.google.com/kml/ for more information.
Then, click on *cb_2016_us_region_500K.zip* under **Download**.

You are downloading this file to your computer. You get the following pop-up:

Make sure the *Save File* button is chosen and then click **OK** to download it to your download folder. Once downloaded, go to your download folder and you will see the following zipped file.

<table>
<thead>
<tr>
<th>Name</th>
<th>Date modified</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>cb_2016_us_region_500k</td>
<td>7/7/2017 4:14 PM</td>
<td>Compressed (zipped)</td>
<td>1,736 KB</td>
</tr>
</tbody>
</table>

Go back to the US Census Bureau KML Cartographic Boundary Files website (the first one) and also download the files for *Nation (US Outline)*, *States*, *Counties* and *Urban Areas*. We can use
Exploring Our Planet with Open Source Software

all five (or more) in Google Earth Pro. Once all five files are downloaded, proceed in this tutorial about unzipping the files.

Right-click on the file and you will see this window:

Click on Extract All…

Use Browse to navigate to the folder where you want to unzip the files.

Once you have chosen the correct folder, click on Extract at the bottom and the following files will be displayed in your file folder:

Perform these unzipping operations for all five downloaded files. Your file folder will look like this once all are unzipped:

Now go back to Google Earth and in the tool bar, click on Open.
Then navigate to where you saved your unzipped files. We are only going to add one KML file right now, so highlight the one for the US Nation, which is the United States outline. Be sure you have highlighted the file type – KML as see below. Once you have highlighted the correct file, click Open.

Once you have opened it, it will add to Google Earth in the Temporary Places Table of Contents and in the Map Window, zooming to the entire US (not just the continental US – see Hawaii in the west and Puerto Rico in the east?). Be patient, it might take a few seconds.
You can add multiple KML files at one time. Go back to File, Open and then navigate back to your folder containing your unzipped files. Highlight each of the other KML files (just the KML type) but holding down ctrl on your keyboard and click on each one to highlight, then click Open.

All the KML files are now added. You can see them listed in your Temporary Places.
You cannot see all of them, but you can turn them on and off by unchecking or checking the box next to the layer name, just as we did under the Google Earth Table of Contents below.

You can also change the symbology for each of your layers. Turn off all the layers except the US Regions. The US is divided by the Census Bureau into 4 regions – West, Northeast, Midwest and South. You can see them displayed in the Map Window -- How do I know the names?
Exploring Our Planet with Open Source Software

Now click on > in front of the name ‘cb_2016_us_region_500k’, just like you did with the layers under the Google Earth Table of Contents.

It expanded the layer to show the individual features. You can change the symbology for all the features so they are the same or change the symbology for each individual one.

To change the symbology so it is the same for all of features, right-click on the name ‘cb_2016_us_region_500k’ and then click on Properties.

You get the dialog box like we have seen before, except it is titled Edit Folder. Click on Style, Color and you can change the symbology here, but it will be the same for all 4 regions.

So let’s do them individually.

First, be sure that the features are expanded so you can see each one of the regions listed.

The right click on any Midwest and click on Properties, you will get a warning message, just click OK.

Go to Style, Color and change the Line color to yellow (click on the blue box to get a color palette) and then under area, click on the drop down menu and click Outlined (we don’t want a fill color, just the outline). Click OK.
The Midwest region will look like this:

Now go back and do the other 3 regions, so your final map looks like this:

One other item to show you and we will go back to the other layers. These layers have metadata. To access the metadata, left-click on any of the feature names and the metadata window opens. Click on Midwest and information shows as follows. The Region CE, AFFGEOID, GEOID, NAME, LSAD are designated by the Federal Government. The other two ALAND and AWATER are the total area of land and water in the region.
Go back and turn off the Region layer and turn on States and Urban Area (UA) layers and make your Map Window, look like this:

One more thing to show you. Expand the layer for Urban Areas. It should look like this:

They are in alphabetical order. There are thousands of features. Left-double-click on Aberdeen MS, it will zoom to Aberdeen and also give you the attributes (metadata) for that urban area. Yes, you could change the individual symbology, but it would take a very long time.
You can save your maps, just like you did with adding a placemark. Go to File, Save and then choose what you want to save:

Before proceeding to the next section, turn off all of your layers in Temporary Places and My Places.

3.9.2 Adding Data from a GPS Unit

For the YouTube video related to this section, go to: https://youtu.be/x6ljzbi0iLo.

If you have a GPS receiver with a USB cord, you can download data directly from that unit into Google Earth Pro. Your GPS receiver must be turned off before you plug the USB cord into the computer. When you plug it in, your computer will turn it on (you do not need a specific program on your computer to load into Google Earth, just follow these steps).
Go to Tools, GPS

You get this window.

Choose the appropriate receiver, in our case it is Garmin.

Then click Import.

If you get this message:

Look at the GPS receiver and make sure it is on and that it shows as an external drive on your computer. If it is not showing, give your computer a minute to recognize it.

Then try Import again. If you are still having problems, contact your IT Department.

But when Google Earth finds your GPS received, which in most cases, only takes a minute or less, you will see this message:

Once the data from your GPS receiver is loaded into Google Earth, you will get this message and Google Earth will zoom to the location of your data. Of course, the number of tracks and track points will vary depending on what you collected on the GPS received. It is highly recommended that you make sure that your GPS has any old information deleted before adding new information.
Exploring Our Planet with Open Source Software

Your GPS receiver will also show in your Table of Contents, under *Temporary Places*.

And the tracks and points will show in the Map Window. The display includes the date of acquisition for data.

You can change symbology, just like you have done with other layers-- the only difference is that you are now working with 3 themes – track, points and labels:
You can also save, just as we have described under previous sections.

So, if you already have GPS data saved to your computer, you don’t need to go find the received data and hope the data is still there. You just Import from file:

which will allow you to navigate to the file folder on your computer where you saved the GPS data (in all likelihood, it was saved as a GPS Exchange file (GPX)).
You can also add saved GPX files by going to File, Open and navigating to the file folder where you have the files. The only difference is that you have to change file type in the bottom of the Open window (red rectangle below) so Google Earth knows to look for a file type other than KML.

Again, you can save it just like we discussed previously.
3.9.3 GIS Vector Shapefiles

One of the features available in Google Earth Pro is the ability to import standard GIS files – raster (or grid) files and shapefiles. If you don’t have access to a raster or shapefile, go to https://www.google.com/earth/outreach/learn/importing-geographic-information-systems-gis-data-in-google-earth/. This site contains a link to two sample files – Rivers in Southeast Asia and Land Cover in Southeast Asia that you can download and use.6

For the YouTube video related to finding GIS Shapefiles to use, go to: https://youtu.be/gH20ARsLixA.

Adding a Shapefile

Go to File > Import …

Navigate to the folder where you have unzipped the files. You may not initially see them, so you will need to change the file type.

If you would rather use shapefiles for US locations, you can access them from the US Census Bureau at their ftp site: ftp://ftp2.census.gov/geo/tiger/TIGER2016/. Most of the shapefile names are self-explanatory, but if you need clarification, click on up to higher level directory.

---

6 If you would rather use shapefiles for US locations, you can access them from the US Census Bureau at their ftp site: ftp://ftp2.census.gov/geo/tiger/TIGER2016/. Most of the shapefile names are self-explanatory, but if you need clarification, click on up to higher level directory.
If you choose All, you will see the following in your Window:

We are going to start with Rivers in Southeast Asia, so add all the files – do it all at one time but clicking on the first file (.dbf) and then hold shift and click on the last file .shx). Click on Open.

You will get the following dialog box. We will explore each option. Start with Import Sample. (Why do a sample? If you have a large number of features, this likely would be better for viewing purposes. Additionally, if you have a large number of features, we can use Regionate, which is discussed later in this tutorial).
Exploring Our Planet with Open Source Software

You will get the next message. Click on Yes. This allows us to set symbology. For the YouTube video on Using GIS Shapefiles with a Style Template, go to: https://youtu.be/wG0WyxqieIY. We also have a video on Using GIS Shapefiles without a Style Template: https://youtu.be/4GXWB3JDMxA.

You now get the following dialog box.
You can click on a field in the table or choose it from the drop down menu – *Set name field*. This will set the field that will show in the Table of Contents. Next click on *Color*. For now, choose *Use random colors*. This will assign a different color to each feature.

Under *Height*, leave the default – *Clamp features to the ground*. 
Then click *OK*. You will get a window to save your *Style template*. Save it because you may want to use the same symbology on another occasion.

Click on *Save*. You will see the file in your Table of Contents, but not in the map window. Google Earth Pro zoomed to the area but no rivers are shown. Why?

The *Rivers in Southeast Asia* file in the table of Contents is not checked. So check it.
Only some rivers are showing, because we clicked on Random Sample. Let’s see what happens when we choose a different setting.

Remove the file by right-clicking on the file name and select *Delete*. 
Import the file again and this time when you get the following message, click on Restrict to view.

You will get the following dialog box. Depending on how zoomed in you are, you may see a different number in this box.

You will get this message again. You already created a Style template. You can reuse the previous one or create one, as we did before, but this time just click No.

Again, the file added but it is not displayed – again, it is not checked in the table of Contents, so check it. Since we did not do a Style template, it assigned one color scheme to all rivers.
Let’s delete it again, add it back in and look at the last option - *Import All*

We leave it up to you if you want to add a style template or not. In the following screenshot, a style template was not used, so all features are symbolized with color. We will experiment with other symbolization later.
Now that you know how to import a shapefile, let’s look at some things we can do with the shapefile.

You can turn individual rivers on and off by checking and unchecking them.

(Remember since we did not do a Style template, when you expanded the file – ‘no name’ shows in the table of contents for each feature).

Clicking on any feature in the map document window brings up information that is in the attribute table for that specific feature:
Clicking on a feature in the Table of Contents will zoom you to that feature and bring up the information from the attribute table.

Right-clicking on one of the features in the attribute table, you can go to Properties (just like in Google Earth Desktop) and change the symbology for that individual feature. Since we have well over 10,000 individual features (river segments), that would take a very long time!
So, let’s get a bit more detailed in setting our symbology. Remove the file again by deleting it. Then add the file back in. Why do we keep repeating these steps? Repetition allows you to learn the process very well.

When you get the following dialog box – choose *Import all:*

Yes to a setting a *Style template.*
When the *Style Template Options* opens, click *Create new template* (if you did not save your prior style template, this dialog box might display). Then Ok.

Let’s choose the country name (field *Name_0* – red oval) to symbolize the rivers (so be sure it shows in the *Set name field* (yellow box)).

Then go to the *Colors* tab.

Fill in this dialog box as shown to the left.

Check *Set color from field*

*Select color field* – make sure *Name_0 Palette start color* – if you click on the box, you can select the specific color shown and then click on end color and you, again, can select the color. Once you do this, the range of colors shows in the bar.

Then click on *create sub-folders for each bucket*. And then *Bucket options* will open, it shows the range of colors that will be assigned for each river feature that is in the specific country listed – we have 4 countries.

These boxes will be blank and you will need to type names of the countries in these boxes, so they are displayed in the Table of Contents.
Exploring Our Planet with Open Source Software

Feel free to change or play with these options. But, you might want to wait until you see what happens with these settings.

Click OK at the bottom.

If your map window does not display the features, again make sure Rivers in Southeast Asia is checked in the Table of Contents.

Please note – you have not changed the shapefile. You have only symbolized it and Google Earth Pro allowed you to save the Style template. You can create multiple different style templates if you want to experiment with what is displayed. Perhaps you are discussing with your students differences in permanent versus fluctuating (ephemeral) streams (HYC_DESCRI), so you symbolize based on that field.

But perhaps, you are just unhappy with the symbology being all shades of blue. You can, again, change the symbology for one of the countries under the Properties. Right-click on the country name and click on Properties. You will get the Edit Folder box. Go to Style, Color and then click on Share Style.
Then choose the color for that country. See screenshot below for suggestions for each country.

You now can turn on and off the rivers for an individual country by unchecking the box next to the country name. Yes, you can expand under the country and see all the features listed, but again, we have over 10,000.
Suppose you would like a file for just one country. Right-click on the name – Laos, then click on Save Place As. You will be taken to a window where you can navigate and save it. You do not need to uncheck all the other layers as seen in this screenshot because you right clicked on the name Laos. Save your file – name it as you wish, here named as Laos Rivers. (Be sure to save it as a .kml, not a .kmz. Both can be added in to Google Earth Pro, but we are going to use the file again later, so it is important to save it as .kml.) It will save as a .kml file, not a shapefile. Once you have saved it, the window closes. No, it is not automatically added to your map.

Now uncheck the Rivers in Southeast Asia file. Then either File > Import or File > Open and add your Laos Rivers files. The symbology is the same because it uses the symbology set before you saved it.

Now turn all the Rivers back on by checking Rivers in Southeast Asia. Like Google Earth Desktop, you have multiple files, .kml, .shp or even raster files in your Temporary Places.

For example, in the following screenshot, the boundary for Cambodia was added as a KML file, but you can add it as a shapefile. Shapefiles for all world countries can be found by searching on the internet, but be careful as to which site to use. If you are unsure if the site is safe, check with your IT Administrator.
3.9.4 Adding a Raster File

You add a raster, or grid file, in the same manner as a shapefile. First, turn off all the files currently in your My Places table of contents.

Now go to Import and import the raster file you downloaded earlier – Southeast Asia Land Cover.
You will get this dialog box. Raster files are very large files, so you don’t necessarily want to add all like we did with the rivers’ vector file. Let’s start with Scale.

You get the following results:
You did receive the properties dialog box (called *New Image Overlay*). You can change some of the default settings. We will not review them here.

But notice, you also have a *Transparency* – so you can see features below. We do not have a color/style option, with land cover those usually come with a default color scheme. Go ahead and set your transparency so you can see some features through the layer. Here, we have it midlevel:

If you find you don’t like the looks, just right click and go to Properties to reopen the dialog box. If you turn your rivers layer back on, you can see the rivers. Although the land cover layer is showing on top in the Table of Contents, in a GIS, raster layers are always displayed underneath vector files.

We will not review the other two options for displaying raster files – *Crop* and *Create Super Overlay*. *Crop* will clip the file to a specific area – for this dataset, it does not crop because it covers a relatively small area. You may explore these on your own.
3.10 Printing a Map from Google Earth Pro

You can print a map in two ways. *File > Print* or clicking on the print icon.

You will see this in your map document window:

The legend carries over from your Table of Contents.

If you hover your mouse over *Untitled Map* box, you get a pencil in order to edit it.
Exploring Our Planet with Open Source Software

You get a pop up box in which you can edit your map name and add a description.

You can change options by clicking on Map Options.
Once you are happy with the way it looks, click on Print or Save PDF.

If you clicked on Save PDF, you will get the following pop-up. Once it is done, you will have a pdf saved to your working folder (where you saved your other items as we worked through this tutorial).

3.11 Regionate

For the YouTube video related to this section, go to: https://youtu.be/p84BgO1ro_w.

For this tool, we are using the kml file that was downloaded -- counties file for all US States. Regionate takes a large dataset and will display detailed features when you are zoomed in on a particular area. This is a memory-saving display mechanism in Google Earth Pro. You do not need to add any files to Google Earth Pro at this point, the Regionate tool will do that after it finishes.
Go to Tools > Regionate

You get the following dialog box. Click on Browse and go to the file folder where you saved the US Counties KML file to add it as the Input file.

Then for the Output folder, a separate folder called Regionate was created (the tool will create a separate .kml file for each county.

Be sure that you have checked – Open regionated files when done. Then click on Regionate.

You will get a status dialog box.
When it is finished, it will look like this:

Zoom into a specific area. Below, search for Colorado and it populates all the counties for Colorado.
Google also has a youtube video to help if you have questions - https://www.youtube.com/watch?v=ZlfPDFgx79I

Now, try the Regionate tool with the Laos Rivers .kml file. Once the tool ran, mine looked like:

Zooming in:
Thus, a very useful tool for discussing only specific regions and not needing to worry about clipping your data.

This ends the Google Earth Pro tutorial. Google Earth Pro has many other options not covered in this tutorial.

**Additional Information:**

You can find Google Earth Pro tutorials at this link:

https://www.google.com/earth/outreach/learn/

https://www.google.com/earth/outreach/tutorials/

If you are interested in staying up to date on Google Earth, the following blog monitors changes on a regular basis:

http://www.portailsig.org/aggregator/sources/13

We have created many YouTube Videos for this chapter, and some of the videos do cover information not covered in this chapter:

1. Introduction to Google Earth
   https://youtu.be/DaluBU8ZO3A
2. Locating KML Files for Google Earth
   https://youtu.be/8bLweAYxQoM
3. Introduction to Google Earth Pro
   https://youtu.be/JStJz-AUYvQ
4. Changing Settings in Google Earth Pro
   https://youtu.be/lXqzT4zUkE0
5. My Places in Google Earth Pro
   https://youtu.be/EJPUY4QDGyI
6. Default Table of Contents, Part 1 in Google Earth Pro
   https://youtu.be/KyiRgT2icME
7. Default Table of Contents, Part 2 in Google Earth Pro
   https://youtu.be/ykILdv3A2TA
8. Measuring in Google Earth Pro
   https://youtu.be/qsCxOsOL5SM
9. Exploring Historical Imagery in Google Earth Pro
   https://youtu.be/7r1ETosfKmU
10. Adding GPS Data to Google Earth Pro
    https://youtu.be/x6Ijzbi0iIo
11. Using a KML File in Google Earth Pro
    https://youtu.be/p2KI-8Gyyh0
12. Finding GIS Shapefiles to use Google Earth Pro
    https://youtu.be/gH20ARsLixA
13. Using GIS Shapefiles in Google Earth Pro, without a Style Template
    https://youtu.be/4GXWB3JDmxA
14. Using GIS Shapefiles in Google Earth Pro, with a Style Template
    https://youtu.be/wG0WyxqielY
15. Using Regionate in Google Earth Pro
    https://youtu.be/p84BgO1ro_w
4. Open Street Map

OpenStreetMap is open source GIS mapping software developed and constructed by volunteers. It covers the entire world and maps have an open content license. Most maps and data are free to the public; mapping and data are accomplished by local people in their own community. The map is not complete and is being updated on an ongoing basis. In this tutorial, we will explain the basics on how to use OpenStreetMap, with screenshots as we progress.

You can use OpenStreetMap for basic navigation and locating features within your community. Or for more advanced students and higher grade levels, OpenStreetMap is an editable map that can be used in your local community to expand features available to users worldwide. We will discuss OpenStreetMap basics and some initial editing capabilities. We will not provide complete details on all OpenStreetMap features and abilities.

We recommend this on-line mapping program for High School level and above. For additional information on OpenStreetMap, see the links at the end of this tutorial.

To access OpenStreetMap, go to [https://www.openstreetmap.org](https://www.openstreetmap.org)
If you click on Learn More (inside the black rectangle above), you will be taken to a website with more information on the OpenStreetMap Foundation and project.

### 4.2 Registering to use OpenStreetMap

In the upper right corner, click on Sign Up.

You are taken to this page where you can sign up. Signing up allows you to see what volunteers have contributed to OpenStreetMap and also allows you to contribute to the program. Fill in the required information.

You will then get this screen, please read the agreement in full. If you agree, then click agree.
You will get an email asking you to confirm that you have registered. Click on the provided link, and you will receive a confirmation, it takes you to a Welcome Page with basic terms for mapping. Click on Start Mapping to log in the first time.
4.3 Navigating in OpenStreetMap

You navigate in OpenStreetMap in many ways. Just like most other open-source GIS software. You can scroll in and out with your mouse wheel. You can also move east, west, north or south by left clicking on your mouse when your cursor is on the map and just dragging. Or you can use the navigation tools in the upper right corner.

To navigate to a specific location, you can use the zoom tools, or the search engine in the upper left of the window:

You can also get direction from one location to another by clicking on the curve arrow at the end of the Search line (red circle above).

We will discuss the Edit, History and Export buttons in another section of this tutorial.

4.4 Understanding the Toolbar on the Right Side of the Screen

We have already discussed the first two buttons, zoom in and zoom out.

The next button is Show My Location. If you click on this button, you will get a message that this website wants to access your computer’s location.

You will need to decide it you want that to occur, or check with your school’s resource or technology officer for instructions.

In the next section, the first button is Layers. When you click on this button, it turns green and the Map Layers’ table of contents opens. Remember, we are at the extent of CONUS, so you see some very general layers. Go ahead and click on each one to see how the map changes at this extent. Don’t zoom in anywhere just yet, we will cover that below.

Next is called Map Key, what we normally think as the map legend. At this extent, only a few things are shown – Motorways, Main Roads and Administrative Boundaries. For this extent, Administrative Boundaries includes a solid purple line for country borders and dotted purple lines for states and provinces within each country.
Now let’s search for a location and see how the map, available layers, and map key change.

Search for Grand Junction, Colorado, don’t forget to click on GO.

As you can see, many layers are now present in the map document – layers that were not present when we first entered OpenStreetMap and were zoomed to the extent of CONUS.

Click on Layers and Map Key to see what has changed.

The Map Key has become quite extensive (note the screenshots below are from using the scrollbar on the right side of the Map Key):
You may have noticed when you clicked on Cycle Map at the extent of CONUS, nothing really showed up. Go ahead and do it now that we are zoomed in. We see features and a Map Key.
Let’s continue with the buttons on the right side of the screen.

Our next button is Share. If you click on this, you get a url link to copy and share.

The last two buttons are Zoom in to add a note to the map and Zoom in to query features. If you are not logged in, neither will be active buttons.

In the following two screenshots, we are not zoomed in far enough to query features. That changes as we zoom in.

But, let’s look at Map Notes first. Click on Map Layers and then underneath Layers, place a check map under Map Notes.

This displays notes on the map where a problem may exist with data that a volunteer mapped. Yes, this is a volunteer project, but map information is verified and if it cannot be verified, a map note is added. In the below screenshot, click on the map note indicated with the orange circle.

As you can seen, whoever mapped it, only described it as 5. If you know what the feature is, you can add it in the description box to resolve it. This one would be a difficult one to resolve, so let’s look at another.

Now click on another one, one of the red balloons with an X. Click on the one shown below with the orange circle below it. A problem with this mapping project, a Pizza Hut was noted here, but as you can see from someone’s notes, never was located here. You can type a message in the open box to help resolve this issue. You could also move the X to the correct location.
Now, let’s look at one that is resolved. Click on the Green Balloon with the check mark:

As you can see, this is a resolved note. OpenStreetMap noted a problem with this volunteer mapping and others were able to resolve it.

So what do you do if you find a problem with features that have been mapped by volunteers?

First, uncheck the Map Notes in Layers and close the Layers table of contents.

If you find a mistake in the map, click the little note on the right toolbar, it turns green.

It adds a blank note box on the left and puts a Blue Balloon with a + and an orange circle underneath on the map. In the box, you type the message indicating the problem with the feature mapped. To put the Blue Balloon on the right place, you place your mouse cursor on the Blue Balloon, when you see the crosshairs, hold your left mouse button down and you can move the Blue Balloon to the correct location.

You may need to zoom in to find the exact location.
Why would you be interested in such a project? This could be a mapping project for your students, adding things to the map and resolving issues that the OpenStreetMap has found, or a project involving getting to know your city and navigating around the city from reality to a representation of your city in a map.

4.5 Query Features

Click on the Question mark and it turns green. This is Query Features. You can then left click on any feature and it provides information.

First zoom in on the green rectangle (indicated by the white arrow in the screenshot on the bottom of the previous page). Once it is a bit larger, click on it.
Then look on the left side of the map. It provides details that have been mapped – Enclosing features. Why isn’t there more information? Remember, this is a volunteer open-source mapping project. If Grand Junction, Colorado is the location of your school, perhaps a mapping project for your class would be to add additional features to the map. Within Grand Junction, we have several roadside sculptures that are permanent features. Such things can be added and might be useful to visitors in the city. Perhaps your city does not even have the streets named. Start with your school location and work outwards.

Let’s talk about two additional buttons, then we can start talking about how to do mapping.

Look at the top of your map – three buttons – Edit, History and Export.

History provides details on mapping within this extent. Clicking on it for this extent of Grand Junction – we have a very active mapping community – some were completed just a few hours ago. It shows who did it (your user name that was set when you signed up, so we don’t know the individual people’s identity). Please note that you can join your local group, or form a local group if one does not exist, to help update the map. Let’s look at Export – just what is sounds. It allows you to export the map. You can export it in the extent showing in the map window (which automatically populates in decimal degrees), you can manually change the extent - one or all four of the boundary lines. You can also choose what map sources to export. Once you are happy with the choices for your export, you click on Export in the blue box.
Exploring Our Planet with Open Source Software

Once the export is complete, you will see the following at the bottom of your map document window:

Click on the ^, then click on open. If you have any difficulty with opening this type of file, please see your IT administration for assistance.

4.6 Editing in OpenStreetMap

You have to be signed in to edit a map. You want to navigate to the area you want to edit and zoom in. OpenStreetMap gives you a step-by-step instruction on editing. Once you click on the down arrow next to Edit, choose Edit with iD.

You will get the following message. You can proceed to Edit Now or Start the Walkthrough. The following screenshots provides the walkthrough.
Exploring Our Planet with Open Source Software

Points can be used to represent features such as shops, restaurants, and monuments. They mark a specific location and describe what’s there.

Click the Point button to add a new point.

Areas are used to show the boundaries of features like lakes, buildings, and residential areas. They can also be used for more detailed mapping of many features you might normally map as points.

Click the Area button to add a new area.

Lines are used to represent features such as roads, railroads, and rivers.

Click the Line button to add a new line.

You’re now ready to edit OpenStreetMap! You can replay this walkthrough anytime or view more documentation by clicking the Help button or pressing the ‘H’ key.

OK
Once you have finished the walkthrough, or if you went straight to start editing, you will see the following -- an aerial photo as your base layer and those features already mapped by volunteers.

Now you need to navigate to the specific place you want to edit. In the following screenshot, I have navigated to the local cable company. The building is on the map (red rectangle) but it has not been identified.

Click on the building to highlight it (the nodes were added) and a window on the left pops up, so you can add the detail.
In this screenshot, detail for the building was added.

Then click on Save (red rectangle) and receive a message to review the changes.
Once received, you will be required to add a Changeset Comment (this is what shows up in History as outlined above). You can review before uploading to make sure your comment is correct, and spelled correctly.

Once you are satisfied, click Upload.

You can also change the aerial imagery that shows as your reference information.
Click on Layers and you can see the optional list of available imagery.

Click on DigitalGlobe Standard Imagery and you receive a much more detailed base image. In this case, add a line feature to extend a footpath that is located along a canal, which can be seen clearly with this imagery.

Click on Line (the button turned blue in the above screenshot), then click on the last node to activate the connection -- following the footpath in the base imagery, adding a node each time
the footpath curved, following the footpath exactly. Once you followed the footpath to the end, double click to stop editing. The next two screenshots shows the detailed information added for the footpath on the left -- metadata. When complete and satisfied with the change, click on Save and once satisfied with your review of the information, click on Upload, as before.

Editing a map is an excellent exercise for students to identify features, understand addresses related to features, understand what type of features are found adjacent to others, and their
relationship. It also allows students to learn and navigate around their local area. Please note that you are contributing to a mapping community, so be sure that your students are of sufficient knowledge and educational level to add accurate information to this open source mapping community.

This concludes this tutorial. You can do many other activities with OpenStreetMap, and this tutorial was just an introduction to get you started.

4.7 For more information and guides to using OpenStreetMap

If you are interested in going a local group or a local chapter, hosting a mapping party or joining the OpenStreetMap Foundation, go to: http://wiki.openstreetmap.org/wiki/How_to_contribute

For more information about OpenStreetMap Foundation, see: http://wiki.openstreetmap.org/wiki/Main_Page

The beginners guide to OpenStreetMap can be found at: http://learnosm.org/en/beginner/introduction/

When using Open Street Map, please be sure to follow all copyright laws. Copyright information for Open Street Map: https://www.openstreetmap.org/copyright

All screenshots within this tutorial are credited to: © OpenStreetMap contributors


Please note that we have not yet completed any YouTube videos related to this chapter.